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This tutorial shows you how to make an electronic circuit using Livewire and PCB Wizard 3. You 
should follow this tutorial to learn the basic skills you will need to use Livewire effectively.

Getting started
In this tutorial you will create a 555 
astable timing circuit similar to the one 
shown on the right. The circuit will flash 
an LED on and off.

PCB Wizard 3 is required.

Along the way, you will learn how to:

Add components from the Gallery
Wire components together
Change component values
Convert the circuit into a PCB layout
Add text to the PCB
View how the finished PCB will look

Components
To make this circuit you will need:

8-pin dual-in-line (DIL) socket
555 timer integrated circuit (IC)
Red LED
1K ohm resistor:

Brown, Black, Red and Gold (4 band)
Brown, Black, Black, Brown and Gold (5 band)

680 ohm resistor:
Blue, Grey, Brown and Gold (4 band)
Blue, Grey, Black, Black and Gold (5 band)

10K ohm variable resistor
100µF electrolytic capacitor
PP3 battery and clip
Single pole, single toggle (SPST) switch

plus suitable PCB making equipment

Difficulty Level: Medium (suitable for moderately experienced users)

Step 1 of 10: Introduction
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You will begin by creating a new (empty) document in which to draw your circuit. To create a new 
document, click on the New button or choose New from the File menu.

Next you will learn how to use the Gallery to add components 
to your circuit. If the Gallery is not currently open, click on the 
Gallery button on the top toolbar to open it.

In the Gallery window, you will be able to see all the 
components that are available within Livewire.

Step 2 of 10: Adding components

Components within the Gallery are grouped according to their function. At the top of the window, a 
drop-down list box allows you to select which group is shown.

From the Power Supplies group, 
add a Battery component from the 
Gallery to your circuit.

To do this:

Move the mouse over the Battery 
symbol. Press and hold down the 
left mouse button.

With the left mouse button still 
held down, move the mouse to 
drag the symbol onto the circuit.

Finally, release the mouse button 
when the circuit symbol is in the 
required position.

To make the 555 timer circuit you will also need several other components.

Add an SPST Switch and a Variable Resistor the Input Components group; two Resistors and an 
Electrolytic Capacitor from the Passive Components group; a 555 Timer from the ICs 
(Analogue/Mixed) group and finally an LED from the Output Components group.

It will help later on if you position the 
components neatly before you start adding 
wires to the circuit.

You can move components by clicking on 
the Select button from the top toolbar.

In Select mode the cursor will appear as a 
standard pointer:

Using the above layout as a guide, try repositioning the components. Thinking about the position of 
components at the start can help produce a much neater circuit diagram.

Pointer cursor
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Once the components have been placed, you can start 
to wire the components together. To do this you must 
first click on the Select button from the top toolbar.

Step 3 of 10: Wiring components together

Next, move the mouse over the top pin of 
the battery (a). As you hold the mouse 
over the pin you will notice a hint appear 
describing that particular component pin.

Press and hold down the left mouse 
button. With the mouse button still held 
down, move the mouse to place a wire. 

To complete the wire, release the mouse 
button over the left pin of switch SW1 (b).

When drawing a wire you can add a bend to a wire by releasing the mouse button over or 
clicking on an empty part of the circuit.

(a)

(b)

You can now wire up the rest of the circuit 
using the diagram on the right as a guide.

Remember that if you get stuck, you can 
always just click on the Undo button to 
correct any mistakes:

Finally, for more detailed help and information 
on wiring circuits, refer to the topic entitled 
Wiring components together in the Help.
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Now that you have drawn the circuit diagram, you can change the component values.

Step 4 of 10: Changing component values

With 555 astable circuits, the timing is controlled by two resistors and a 
capacitor. In your circuit these are R1, VR1 and C1.

The rate at which the LED will flash is determined by the following equation:

Double-click on variable resistor VR1 to display the Variable Resistor Properties window (above).

The Value field for the variable resistor is shown at the bottom of the window and consists of both a 
value and a multiplier. The variable resistor's value (in ohms) is calculated by multiplying the value by 
the multiplier.

It is good practice for 
one of the timing 
resistors in a 555 
astable to be a variable 
resistor as it allows the 
rate to be adjusted once 
the circuit has been 
manufactured.

where R1 is 1K (or 1,000), VR1 is 50K (50% of 100K, or 50,000, when the 
slider is in the mid position) and C1 is 100µF (or 0.0001). This gives a 
frequency (f) of 0.14 Hz (Hertz) which would result in the LED flashing about 
once every 7 seconds (since flash rate = 1 / frequency).

To make the LED flash at a faster rate, the 100K variable resistor will be 
replaced with a 10K variable resistor. Using the above formula, repeat the 
calculations using this new value. How often would the LED now flash?

Finally, you will need to change the value of resistor R2. In your circuit, 
resistor R2 will be used to limit the amount of current that passes through 
the LED. It is good practice to include current-limiting resistors when 
using LEDs; without them, LEDs may be damaged or even destroyed.

As a 9 volt battery has been used, the value of this current limiting 
resistor will need to be changed to 680 ohms which would limit the 
current flowing through the LED to about 10mA (milli-amps).

Double-click on resistor R2 and change its value to 680. Remember that 
you will also need to change the multiplier from K (x 1,000) to blank (x 1).

In your circuit, the variable resistor should have a value of 10K. Enter 10 in the first value box but 
leave the multiplier unchanged at K (x 1,000).

Value Multiplier, where:
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Now that the 555 timer circuit is complete, you can convert it into a printed circuit board. This 
requires PCB Wizard 3 to be running on your computer.

From the Tools menu choose Convert | Design to Printed Circuit 
Board. You will see a window appear to lead you through the 
conversion process. The window contains a series of pages that allow 
you to decide how your circuit is converted.

For more information on the options available for converting your circuit diagrams into PCB 
layouts, see the topic entitled Converting to a PCB layout in the Help.

These pages cover areas such as the size and shape of your PCB layout, which components are 
used as well as more advanced features such as automatic routing and component placement.

Click on the Next button. You will then see the first page of options (see below).

Within this page you can select the size and shape of the printed circuit board that is produced.

You can either choose to enter a specific size or have Livewire calculate a size based on the 
components within your circuit. For your 555 timer circuit a specific size will be chosen.

Click on the I wish to specify a size for my printed circuit board option. The Width and Height 
boxes will then become available. Enter '2 in' in the Width box and '3 in' in the Height box. If you wish 
to use metric measurements then you can enter '50 mm' and '75 mm' respectively.

In the Width and Height fields, you can type in a different unit of measurement to the one given. 
For example, you could type in '65 mm', '4 in' or even '3500 mil' (where a mil is one thousandth 
of an inch). The available units are mm, cm, m, in, pt and mil.

To change the unit of measurement used throughout the entire application, choose Options from 
the Tools menu and select a different Measurement unit from the General tab.

Step 5 of 10: Converting the circuit into a PCB layout (1) 
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Clicking on the Next button will show you how your components will be converted.

The window lists each component in your circuit. If you wish to change how a particular component is 
converted, double-click with the left mouse button on the a component from the list and then select 
an appropriate PCB component from the window that appears.

Once you have specified the components, click on the Next button again. 

The page that appears allows you connect any digital components to a power supply such as a 
battery. As your 555 timer circuit does not contain any digital components, these options can be 
skipped so click on the Next button one more time. You will then see the page below.

Step 6 of 10: Converting the circuit into a PCB layout (2) 

It is within this page that you can control how the components are positioned on the board. The 
default settings shown above will be suitable for your 555 timer circuit.

Specify 
package to 
be used
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After clicking on the Next button, the automatic routing options will be shown.

The Grid option should be set to 0.050" grid with 0.020" tracks. This will make it possible for tracks 
to be routed through the legs of an integrated circuit (a 555 timer in your case).

With the options set as shown above, click on the Next button. The page below will then appear.

Step 7 of 10: Converting the circuit into a PCB layout (3) 

On this, the final page of options, you have the opportunity to add areas of solid copper to your 
printed circuit board. Copper areas help reduce costs by limiting the amount of etching solution that 
is required when the circuit is eventually manufactured.

By default this setting is switched on, with an isolation gap of 0.03". For your 555 timer circuit, you 
should keep the settings the same.
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Step 8 of 10: Converting the circuit into a PCB layout (4) 

With all of the options specified, you are ready to convert your circuit. Click on the Convert button.

Livewire will now link to PCB Wizard 3 in order to create a printed circuit board for your 555 timer 
circuit. You need to ensure that the PCB Wizard 3 is software is already running.

The first step in the conversion process is for an outline of 
the board to be created. This is shown on the left as a blue 
rectangle.

Next, you will see each component added to the board. 
This is known as automatic component placement. 
PCB Wizard calculates the optimum position for each 
component in your circuit.

As the components are positioned, you will also see a 
series of green lines. These are known as nets and 
represent electrical connections between the components.

With the components in position, PCB Wizard will then add the 
necessary copper tracks during a process known as automatic 
routing. A path, or route, is found for each connection such that 
it does not touch any existing tracks on your circuit. Unlike 
wires on a circuit diagram, copper tracks on a printed circuit 
board cannot overlap.

Finally, at the end of the process, a solid copper area will be 
added to your printed circuit board. 
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Step 9 of 10: Adding text to the PCB layout

You will now be in PCB Wizard with your circuit on the screen.

Next you will use copper labels to add text to your printed circuit board. Copper labels will help you to 
identify your printed circuit board once it has been manufactured.

To add a copper label choose Copper Label from the Insert menu.

Next, click with the left mouse button somewhere on your circuit (you do not need to be very precise 
as you will be able to reposition the label later). A window will appear allowing you to type text for the 
label and specify the layer on which it will reside (see above).

Finally, move the rotated label into the top-left hand corner of the 
board (as shown on the left). Remember that as the label will be 
made of copper (since it is on the solder side layer), it must not 
overlap any existing pad or track in your circuit.

Enter a caption of '555 Timer Circuit' and then click on the OK button. Your 
label will then appear on the circuit.

Notice how the text in the label has been reversed. This is so 
that the label will appear the correct way around when the PCB 
is eventually made. Any copper labels placed on the solder side 
layer (the underside of the PCB) are automatically reversed.

To fit the label more neatly on your board, you will need to rotate 
the label by 90 degrees. Select the label and then click on the 
Rotate Left button on the top toolbar.

Select copper label text
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Step 10 of 10: Viewing how the finished PCB will look

With your printed circuit board now created, you can see how it will look when made.

On the left-hand side of the main PCB Wizard window, you will see the Style 
toolbar. This toolbar shows the different ways in which your circuit can be viewed.

Note that the available Style buttons differ from those shown in Livewire.

Click on the Real World button. The display of your circuit will change to show you 
how your circuit would look if it were professionally manufactured (a).

Next, click on the Artwork button. You now see the artwork (or mask) for your 
circuit (b). It is this artwork that you would use to make the printed circuit board.

To see how a professionally manufactured circuit would look prior to the components 
being soldered in place (c), click on the Unpopulated button.

Finally, try clicking on the Prototype button. This is how your circuit would look if 
made as a one-off prototype (d).

You can use the above styles to help when manufacturing the finished printed 
circuit board. In particular, the Real World and Unpopulated views of your board 
will show where each component needs to go.

(a)

(b)

(c)

(d)


